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Revision A00

The WaveShaper Help covers the general operation of the WaveShaper Series 'A' products and the WaveShaper 1.4 software
package which includes the WaveShaper App and the WaveShaper Webserver.

It is not valid for other hardware or software versions.

For information about the WaveShaper Series 'A' range, please visit the Finisar Optical Instrumentation website.

For detailed technical help, please visit the Finisar KnowledgeBase website. (www.finisarknowledgebase.com)
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Section 1 Overview

1.1 Safety Considerations

The following general safety precautions must be observed during all phases of operation, service, and repair of this module.
Failure to comply with these precautions or with specific warnings elsewhere in this manual violates safety standards of design,
manufacture, and intended use of the instrument. Finisar assumes no liability for the failure to comply with these requirements.

This product has been designed in accordance with IEC Publication 61010-1, Safety Requirements for Electrical Equipment for
Measurement, Control and Laboratory Use, and IEC Publication 60825-1 Safety of Laser Products - Part 1: Equipment classification
and requirements and has been supplied in a safe condition. This documentation contains information and warnings that must be
followed by the user to ensure safe operation and to maintain the product in a safe condition. Before operation, you should review
the instrument and manual for safety markings and instructions. You must follow these to ensure safe operation and to maintain
the instrument in safe condition.

To avoid electrical shock, do not perform electrical tests when there are signs of shipping damage to any portion of the outer
enclosure.

Laser Safety

The WaveShaper family of Programmable Optical Processors are designed for use with various classes of laser up to, and including,
Class 3B lasers. Whilst the WaveShaper module does not generate laser light, laser light may be present on one or more output
ports depending on the configuration of WaveShaper selected and the type of laser connected to the input port(s). Please pay
attention to the following laser safety warnings:

Under no circumstances look into the end of an optical output cable/connector(s) when the device is operational. If
there is any laser radiation it could seriously damage your eyesight.

Do not operate the WaveShaper without attaching the optical output connector(s) to a safely terminated mating
connector(s).

Refer servicing only to qualified and authorized Finisar personnel.

Electrical Safety

The mains-powered versions of the WaveShaper require single-phase AC, 100–240V, 50–60Hz and has a maximum power
consumption of 50VA. In accordance with international safety standards, the instrument has a three-wire power cable. When
connected to an appropriate AC power receptacle, this cable earths the instrument chassis. To avoid the possibility of injury or
death, you must observe the following precautions before switching on the instrument.

Insert the power cable plug only into a socket outlet provided with a protective earth contact. Do not negate this
protective action by using an extension cord or power block without a protective conductor.

Do not interrupt the protective earth connection intentionally.

Do not remove protective covers. Operating personnel must not remove instrument covers. The unit contains no user-
serviceable components. Component replacement and internal adjustments must be made only by qualified Finisar
service personnel.

A WaveShaper chassis that appears damaged or defective should be made inoperative and secured against unintended
operation until it can be repaired by qualified Finisar service personnel.

A defective, damaged, or malfunctioning WaveShaper chassis must be returned to Finisar for repair.

The module versions of the WaveShaper are designed to operate from a user-supplied +5V supply.

The module contains Electrostatic Discharge Sensitive Devices.

Operating personnel must not remove the module lid. The module contains no user-serviceable components.
Component replacement and internal adjustments must be made only by qualified Finisar service personnel.

A WaveShaper module that appears damaged or defective should be made inoperative and secured against unintended
operation until it can be repaired by qualified Finisar service personnel.
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The module is supplied with a mating Phoenix power plug which needs to be wired to a power supply capable of providing +5V to
+5.6V at a current of at least 8A. The wire used should be red for +5V and black for 0V 22AWG (0.5mm,16/0.2,Tri-rated PVC
insulated UL1015).

1.2 LCoS Introduction

Conventional liquid crystal components used in telecom applications employ control of polarisation state to pass or transmit light
to create for example wavelength blockers or attenuators. Switching applications can be achieved through polarisation dependent
deflection or displacement. These designs are limited by having inflexible configurations – typically with one pixel per channel -
and the requirement to preconfigure the channel plan in advance.

Liquid Crystal on Silicon (LCoS) is a display technology which combines Liquid Crystal and semiconductor technologies, to create
a high resolution, solid-state display engine. The diagram shows the structure of an LCoS display with the Liquid Crystal (LC) layer
sandwiched between the Active Matrix silicon backplane and the ITO-coated (Indium Titanium Oxide) top glass.

1.3 Optical Design

LCoS can be employed to control the phase of light at each pixel to produce beam steering. In the WaveShaper, a large number of
phase steps are used to create a highly efficient, low-insertion loss switch shown schematically in this diagram. This simple optical
design incorporates polarisation diversity, control of mode size and a 4-f wavelength optical imaging in the dispersive axis of the
LCoS providing integrated switching and optical power control.

Light enters the device from a fibre array, and is then processed by polarisation diversity optics to align orthogonal polarisation
states to maximize efficiency at the diffraction grating. The grating is designed to be at Littrow incidence, and angularly disperses
the light to the LCoS array, where the reflected light is traced back through the system to the chosen output fibre, based on the
beam-steering image programmed on the LCoS array.

As the wavelengths are separated on the LCoS the control of each wavelength is independent of all others and can be switched or
filtered without interfering with other wavelengths.
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Section 2 Connecting via Ethernet

2.1 Connecting to the Waveshaper

Connection to multiple Series A WaveShapers can be made through a LAN or Internet connection where each WaveShaper is
addressed by a unique IP address. The connection is through http commands which make the control interface platform
independent. Windows, OS X, Android, iOS, Linux, etc...are all supported.

All Series A WaveShapers can be controlled through one of four techniques:

WaveShaper App Graphical User Interface (Ethernet only)

RESTful HTTP Commands (Ethernet Only)

WaveManager 2.7.4 and above (USB only, backward compatible)

WaveShaper API (USB only, backward compatible)

This help document covers the WaveShaper App and RESTful HTTP Commands - for details on the WaveManager 2.7 and API,
please see the relevant documentation on the Finisar website.

2.2 Ethernet Connection

There are two programs used to connect to the WaveShaper through the Ethernet port. The WaveShaper App is installed on
Windows operating systems and the WaveShaper Webserver is installed on each Series 'A' WaveShaper for control through HTTP.
Note that the App and Webserver are identical and vary only in the location that they are stored. The functionality for both is
identical.

WaveShaper App

The WaveShaper App is a Windows program that will run on Windows 7, 8.1 and 10 systems. It can be installed from the USB drive
that is supplied with the WaveShaper or it can be downloaded from the Finisar website.

When the program is run, the WaveShaper Connect window will open and run a search for any WaveShapers connected to the
network.

It will then show a list of WaveShapers currently connected to the network. The information shown will be the WaveShaper model
number, serial number and IP address.
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The "connect" button will open up the WaveShaper App which is a program built using HTML5 and JavaScript.

The "open in browser" button will connect to the webserver on the WaveShaper and it will open in the default web browser
installed on the computer.

The WaveShaper App must be used to install any WaveShaper Firmware updates that may be required through the Tools option.

WaveShaper Not Found?

If the WaveShaper connected to the network does not appear then the "Not Found?" button will connect you to the connection
troubleshooting section of the help file.

WaveShaper Connect Menu Options

The WaveShaper Connect contains a number of menu options.

File > Exit (Ctrl + E): Shortcut to exit the WaveShaper Connect program.

WaveShaper > Custom IP Address: Used to connect to a WaveShaper on the network that has a fixed IP address and is
not discoverable through the WaveShaper Connect program. Type the IP address into the window then click on the
connect button.

Help > Help: Connects to a standalone help window showing the contents of the help file, without the icon ribbon of
the WaveShaper App.

Help > Quickstart Guide: Opens up a PDF version of the Quickstart Guide shipped with the WaveShaper.

Help > KnowledgeBase: Connects to an online address that is dedicated to answering more technical questions about
the WaveShaper and WaveAnalyzer family of products from the Optical Instrumentation Group of Finisar.

Help > About: Shows the currently installed version number of the WaverShaper App.

2.3 Webserver Browser Interface

The WaveShaper Series A instruments contain an in-built webserver. Any operating system with a Web Browser can connect to the
WaveShaper directly by sending HTTP commands directly to the unit. No dedicated software or drivers are required.

There are two addresses that can be used to connect to the WaveShaper.

mDNS address: for example WS200427.local where the WS200427 is the serial number of the WaveShaper. Once
connected, the IP address will appear in the address bar: http://ws200427.local/waveshaper.html#/basic

IP address: for example typing 10.118.6.194 directly into the address bar. The IP address can be obtained by using the
WaveShaper Connect program found when installing the WaveShaper App. Once connected, the IP address will appear
in the address bar: http://10.118.6.194/waveshaper.html#/basic

The WaveShaper Webserver can be used in conjunction with the following browsers:

Firefox

Chrome

Safari

Internet Explorer version 11 and above

Microsoft Edge
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The WaveShaper can be controlled using the web browser on a hand-held device such as a tablet or phone. However, performance
has been optimised for use with a mouse and keyboard and not all functions may operate correctly when used with a touchscreen
device.

2.4 Can't find the WaveShaper?

If the WaveShaper connected to the network does not appear in the WaveShaper Connect window, then try these steps:

Ensure that the WaveShaper is connected to the LAN before powering-on the instrument. The network will only assign
an IP address to the WaveShaper if it is connected to the network before powering on. The default WaveShaper IP
address may cause some issues in some network configurations.

If the WaveShaper still does not appear, it could be due to changes made to the WaveShaper IP settings. The
WaveShaper IP setting can be reset to the default mode with the reset switch. The default mode is "DHCP then Fixed
IP".

While the WaveShaper is running, press and hold the reset switch at the back of the instrument for at least 5
seconds.

Let go of the reset switch and afterwards power cycle the WaveShaper.

The WaveShaper should then be discoverable in the WaveShaper Connect window.

For further detailed technical help, please visit the Finisar KnowledgeBase website.

If there are still connection issues, then please contact us by email: waveshaper@finisar.com

2.5 WaveShaper Mac Address

For both the Module and Benchtop, the MAC addresses of the USB and Ethernet interfaces are printed on the Serial Number
Label.
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Section 3 Graphical User Interface

3.1 Filter

3.2 Shape

Optical Filter Profile

For all Series A WaveShapers except the 100A, a preset optical
filter profile can be applied which is defined either by simple
internal profiles stored within the WaveShaper (Flat-top Band-
pass, Gaussian Band-pass or Band-stop) or from a user-
specified filter stored on the users’ computer. (For a
WaveShaper 100A, only the internally-defined Flat-top and
Gaussian Band-pass filter shapes are available).
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Changing the Optical Filter Profile

When controlling a WaveShaper, the user can select the filter
shape from a drop-down list comprising all pre-programmed
filters (Bandpass, Gaussian, Bandstop), together with User
Configured Filter (UCF) and WaveShaper Preset (WSP) files
stored on the user’s computer. To upload a new *.UCF or
*.WSP file to the WaveShaper, either select it from the drop-
down list or drag and drop it to the indicated area on the
control panel. In all cases, it is necessary to click "Apply" to
upload the new profile.

3.3 Control

Center

This allows the user to set the center frequency of the filter and
is programmable in 1 GHz steps. The value which can be
entered is limited to the operating range of the unit. Center
Frequency control is not available if a WSP file is selected.

Bandwidth

This allows the user to change the bandwidth of the filter
selected in 1 GHz increments. The display shows the nominal 3
dB bandwidth selected. The change in the bandwidth is
symmetric to within ±2 GHz around the center of the filter.
Note: The bandwidth control is accurate for values down to
approximately 20 GHz, below this value the bandwidth
approaches the instrument’s optical transfer function of
approximately 10-12 GHz. Bandwidth Control is not available if
a *.WSP or *.UCF file is selected.

Attenuation

The Attenuation Control provides a power control function for
the current filter. Attenuation control is not available for the
100A or if a WSP file is selected.

Port

The Port Selector Control is only available for the 4000A and
16000A range of Series A WaveShapers. Port Control is not
available if a WSP file is selected.
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4000A

The port selector allows the user to select the port to which the
output is directed. The default value after start-up is Port 1.

16000A

The 4x16 configuration is the default configuration loaded up
when the WaveShaper App is first started. The default values
after start-up are Input Port A and Output Port 1.To select any
of the other available configurations, use the WaveShaper
Configuration option in the Tools tab.

Phase Control

The drop down list box lets the user select how to define one of
phase, group delay or dispersion control values for the
WaveShaper.Phase control is not available for the WaveShaper
100A or WaveShaper 500A or if a *.wsp file is selected.

Phase

Allowable range: -2π to 2π rad

Delay

Allowable range: -25 to 25 ps

Dispersion

Allowable range: -100 to 100 ps/nm (for a 50 GHz bandpass
filter)

3.4 Graph Control

PAN

Allows you to grab the trace and move it to a different part of the graph. The
axes numbers will update automatically. To RESET, use the ZOOM icon and
zoom out.
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ZOOM

Allows you to zoom in on an area of interest. To Zoom IN, drag with the mouse
from top left to bottom right. To Zoom OUT or RESET the graph, drag the
mouse from bottom right to top left on the graph. The axes numbers will
update automatically.

TRACE

Allows you to select and deselect port traces as well as define which graphs are
visible in the WaveShaper App window.

3.5 Advanced

Spectral Range Control

This control allows the user to control the spectral range and, if
required, the repeat function, over which a filter function is
applied. The Window function is used to limit the applied
range of a UCF and also to define the region of the frequency
spectrum which is updated when the "Apply" button is
pressed. The control allows the user to set the 6 dB window
applied to the selected filter in 1 GHz increments from 10 GHz
up to the operating range of the unit. The change in the
window is symmetric around the center of the filter.
Adjustment of the Window is through direct editing in the
entry box. Note: The Window control is accurate for values
down to approximately 20 GHz. Below this value the
bandwidth approaches the instrument transfer function of
approximately 10 GHz.

Repeat Function

The repeat function allows the user to specify repeat
applications of this filter at a specified frequency gap for
a specified number of times (up to the operational limit
of the unit). The Window function is defined at 6 dB as
this is the value which is required to ensure that the
function can be stacked one-against-the-other for use
when switching signals using the WaveShaper 4000A or
16000A to emulate a Wavelength Selective Switch. For a
mathematical derivation of this, see the White paper
entitled "Filter Bandwidth Definition of the WaveShaper
S-series Programmable Processor" available on the Finisar
website.
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3.6 Sketch

For all Series A WaveShapers except the 100A, the Sketch application provides a powerful and intuitive graphical user interface for
controlling the attenuation, phase, group delay or dispersion of a WaveShaper in real time. With a double-click of a mouse, users
can create data points in the WaveShaper frequency spectrum and, based on the selection of the interpolation method between
the data points, Sketch creates a visual representation of the profile which is loaded into the attached WaveShaper device in real
time.

Sketch provides graphical tools to create, drag and drop, single data points and area selected sets of data points. It has selected
area zoom in and full view reset capability for the graphical view. The created filters can be saved as Preset Point Data files for
future use and exported as WaveShaper Preset (*.wsp) files for later downloading direct to supported WaveShapers.

3.7 Mode

Mode Selection

Select what is to be controlled from a drop-down menu. For
the 500A, only the attenuation option is available. When the
Phase, Group Delay and Chromatic Dispersion are selected, a
second graph will appear below the attenuation sketch graph.
A grid can be applied to the second graph for ease of
selection.
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Attenuation and Phase

Allows the adjustment of the phase in the bottom
window. The phase sketch points are blue. The
allowable range is -2π to 2π radians.

Attenuation and Group Delay

Allows the adjustment of the Group Delay in the
bottom window. The phase sketch points are green.
The allowable range is -25 to 25 picoseconds.

Attenuation and Chromatic Dispersion

Allows the adjustment of the Chromatic Dispersion
in the bottom window. The phase sketch points are
orange. The allowable range is -100 to 100 ps/nm
(for a 50 GHz bandpass filter).

3.8 Shape

Grid Selection

Select an existing sketch grid file from the drop-down list or
upload a new file by dragging and dropping it to the
indicated area on the control panel. This allows for easy
selection of predefined points.
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3.9 Control

Interpolation

This allows the user to select the type of interpolation used by
the sketch program to generate the WaveShaper filter profile.
The interpolation takes place between the data point or
points selected and the nearest sketch points on either side.

Nearest Neighbour

Produces a square shaped profile when the points
are adjusted. The points can be adjusted for both
attenuation (vertical direction) or frequency
(horizontal direction).

Linear

Produces a triangular shaped profile when the
points are adjusted. The points can be adjusted for
both attenuation (vertical direction) or frequency
(horizontal direction).
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Cubic Hermite

Produces a rounded profile when the points are
selected. The points can be adjusted for both
attenuation (vertical direction) or frequency
(horizontal direction).

Frequency Lock

When frequency lock is switched on, the frequencies
of any existing points are locked and they can only
be dragged in the vertical (y-) direction (attenuation
adjustment). This allows for the manipulation of the
set channels.

Port

The Port Selector Control is only available for the 4000A and
16000A range of Series A WaveShapers. Port Control is not
available if a WSP file is selected. This allows the user to select
the port to which the output is directed.

Port Selection 4000A

The default value after start-up is Port 1. The user can use the
drop down control to select any of the 4 available output
ports.
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Port Selection 16000A

For the 16000A all ports are indicated by two characters. The
first character is the input port and the second is the output
port. The default configuration file is 4x16 and the default
value for this configuration is A-1. The user can use the drop
down control to select any of the 64 available output ports.
The port selection list will be different for each configuration
and the port list will change depending on the configuration
that is currently active.

4x16 configuration, 64 ports, default A-1

1x19 configuration, 19 ports, default A-B

8x12 configuration, 96 ports, default A-5

10x10 configuration, 100 ports, default A-7

To select any of the other available configurations, use the
WaveShaper Configuration option in the Tools tab.

3.10 Graph Control

DRAW

Allows you to directly manipulate points on the sketch trace. See the section on
Modifying Points for more details.

PAN

Allows you to grab the trace and move it to a different part of the graph. The
axes numbers will update automatically. To RESET, use the ZOOM icon and
zoom out.

ZOOM

Allows you to zoom in on an area of interest. To Zoom IN, drag with the mouse
from top left to bottom right. To Zoom OUT or RESET the graph, drag the
mouse from bottom right to top left on the graph. The axes numbers will
update automatically.
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3.11 Sketch Manipulation

Selecting Points

Click on a single point to select that point. The point
will turn a bright orange colour. By clicking and
dragging that point, you can change the shape of
the sketched profile. Click anywhere else in the
graph area to deselect the point.

Adding Points

Double click on the sketch graph area to add a point
to the sketch profile. This extra data point can be
manipulated by selecting and dragging the point
around in the graph window.
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Grouping Points

Click and drag the mouse to select a group of
points. The selected points turn a bright orange
colour. The group of points can be manipulated by
dragging to a different area in the graph. Clicking
elsewhere in the graph will deselect those points.

Deleting Points

Select a single point or a group of points. Hitting
the delete button will delete the selected point or
points.

Undo and Redo

The Undo and Redo buttons allow you to go back and forward through a
number of changes made to the sketch profile. It will also restore deleted
points from the sketch profile.
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3.12 Pulse Shaping

Pulse shaping is a powerful optical technique whereby the frequency-domain of a pulse or sequence of pulses is manipulated in
order to alter its properties. The dedicated control page in the WaveShaper App allows precise and easy control of the pulse
amplitude and phase to completely define the temporal (or spectral) properties of a laser pulse. The pulse shaping function is
available for all versions of the 1000A, 4000A and 16000A WaveShaper instruments.

3.13 Pre-Filter Shape

Available Filters

Defines a basic filtering scheme. Typically, this pre-filtering is
used to achieve a transform limited pulse shape. The user can
select the filter shape from a drop-down list comprising pre-
programmed Bandpass and Gaussian filters as well as the
option of having "No Filtering".

User Filters

In addition to his this, User Configured Filter (UCF) and
WaveShaper Preset (WSP) files can be uploaded to the
WaveShaper. To upload a new *.UCF or *.WSP file to the
WaveShaper, either select it from the drop-down list or drag
and drop it to the indicated area on the control panel. In all
cases, it is necessary to click "Apply" to upload the new profile.
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3.14 Pre-Filter Control

Center Frequency

This allows the user to set the center frequency of the filter and
is programmable in 1 GHz steps. The value which can be
entered is limited to the operating range of the unit. Center
Frequency control is not available if a WSP file is loaded.

Bandwidth

This allows the user to change the bandwidth of the filter
selected in 1 GHz increments. The display shows the nominal 3
dB bandwidth selected. Bandwidth Control is not available if a
*.WSP or *.UCF file is loaded.

Attenuation

The Attenuation Control provides a programmable insertion
loss for the current filter. Attenuation control is not available if
a WSP file is selected.

Dispersion

Dispersion can be controlled in two modes: Linear (ps/nm) and
Quadratic (ps/nm2).

3.15 Output Pulse Shaping

Pulse Selection

Allows the user to select from a number of output pulse shapes.
These output pulse shapes will be created in the case where a
transform limited pulse has been generated with the “Pre-Filter
Shape” function.
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Gaussian Pulse Shaping

The control option for Gaussian Pulse Shaping is
the pulse length adjustment. This example has a
bandwidth of 10nm and a pulse length of 10ps.

Flat Top Pulse Shaping

The control option for Flat Top Shaping is the
pulse length adjustment. This example has a
bandwidth of 10nm and a pulse length of 10ps.

Triangle Pulse Shaping

The control option for Triangle Pulse Shaping is
the pulse length adjustment. This example has a
bandwidth of 10nm and a pulse length of 10ps.
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Parabolic Pulse Shaping

The control option for Parabolic Pulse Shaping is
the pulse length adjustment. This example has a
bandwidth of 10nm and a pulse length of 10ps.

Double Pulse Setting

The control options for Double Pulse Shaping are the pulse
length adjustment and the percentage of power to be
distributed to each pulse. The power percentage is set by the
user. The power percentage and phase are then automatically
calculated by the software.

Double Pulse Shaping

This example has a bandwidth of 10nm and a
pulse length of 10ps and a power1 percentage of
50%.

3.16 Graph Control

PAN

Allows you to grab the trace and move it to a different part of the graph. The
axes numbers will update automatically. To RESET, use the ZOOM icon and
zoom out.
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ZOOM

Allows you to zoom in on an area of interest. To Zoom IN, drag with the mouse
from top left to bottom right. To Zoom OUT or RESET the graph, drag the
mouse from bottom right to top left on the graph. The axes numbers will
update automatically.

TRACE

Allows you to select and deselect port traces as well as define which graphs are
visible in the WaveShaper App window.

3.17 Tools

The tools interface is used to make configuration changes to the WaveShaper. It also provides feedback about the device
connected as well as provides an interface to obtain system log information.

3.18 Wavelength/Frequency Selection

Wavelength Unit

Use this tool to select units of either Frequency (THz) or Wavelength
(nm).
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3.19 Network configuration

Current Settings

The Network Configuration will give you the current network IP
address settings including the current Fixed IP and Mask
addresses.The Gateway address is a router interface connected
to the local network that sends packets out of the local
network. It is used to allow access to the WaveShaper from a
different subnet or Internet. The default setting is blank.

Changing Network Settings

Use this tool to change the network configuration
of the WaveShaper. Click on the "Change" button
to view the change options.To confirm the options,
click on the "Apply" button. To go back without
making changes, click on the "Hide" button.If
running the WaveShaper App, then you can reboot
the WaveShaper using the "Reboot" button in the
System options. Otherwise you can power cycle the
WaveShaper to apply the changes.

DHCP then Fixed IP

DHCP then Fixed IP is the default setting. If the program
cannot find an IP address using the DHCP network
assignment then it will attempt to connect to the default
fixed IP address of 169.254.6.8.

Fixed IP

Fixed IP address can be setup so that a permanent IP
address is assigned to the WaveShaper. This can be
helpful when setting up a test system and the test
program can send commands to the same fixed IP
address. It is common that after a new IP setting is
programmed into the instrument, the WaveShaper will
no longer be detectable under the current network
connection.

WaveShaper A Series User Manual

25



DHCP

The DHCP option is used to allow the network
configuration to assign the IP to the WaveShaper. This can
change depending on the network configuration. For
example, by typing in "WS200427.local" directly into the
browser address, this will connect to the WaveShaper no
matter what IP address has been assigned by the DHCP
server.

Reset Button

If a connection cannot be made to the
WaveShaper due to changes made to the
IP settings then the IP setting can be reset
to the default "DHCP then Fixed IP"
mode.To do this, press and hold the reset
switch at the back of the WaveShaper for
5 seconds whilst the WaveShaper is
powered on. The WaveShaper will then be
discoverable in the WaveShaper Connect
mode or with the "WS200427.local" IP
address in a browser.

3.20 Logging

Download Log

The logging function is used to download a log file of the WaveShaper
activity.This is helpful for troubleshooting purposes. When contacting
Finisar with any potential issues, please download this file and send this
by email to the Customer Support team.

3.21 Device Information

WaveShaper Details

Used to provide feedback about the device currently connected
to the WaveShaper App.
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3.22 System

System Update

The purpose of the System update is to allow the
WaveShaper App to update the WaveShaper Webserver
located on the instrument.The WaveShaper App and
WaveShaper Webserver are essentially the same program;
the only difference being that the WaveShaper App will
show the "System" update menu item. The WaveShaper
Webserver which resides on the WaveShaper will not have
the System update option available in the tools menu.

.wspkg file

The "Update" button is used to upgrade the firmware of the
WaveShaper, in effect upgrading the Webserver program
stored on the unit. The firmware file is in the form of a .wspkg
file.Any updates to the WaveShaper Firmware will be made
available either through the Finisar website or through contact
with the WaveShaper Customer Support.A copy of the .wspkg
file that shipped with the instrument is available in the local
program file folder:C:\Program Files
(x86)\Finisar\WaveManager\waveshaperapp\firmware

Update Process

To update the firmware, click on the "Update"
button then browse to the location where the
WaveShaperSystem.wspkg file has been saved.
Click on the "Open" button.Once the
WaveShaper has been updated, a message will
appear, prompting you to "Reboot" the
WaveShaper.Note that the power needs to be
kept on during the update process otherwise the
system can become corrupt and the
WaveShaper will not connect.

Reboot

Click on the "Reboot" button or power cycle the device and wait until the
reboot sequence is complete.During the reboot process, the screen will turn
grey, preventing any interaction with the controls.Following a reboot, the
updated Webserver program will be uploaded to the WaveShaper when the
WaveShaper is next connected to the PC.

3.23 WaveShaper Configuration

Configuration Selection for 16000A Only

This Tools menu option appears just below the Wavelength Unit
selection and only appears for the 16000A WaveShaper. Use this tool
to select a different configuration file.For a 16000A, the 4x16
configuration is the default. After selecting the desired configuration
from the list and clicking on the Apply button, the WaveShaper will
reboot automatically and load the new configuration.Note that the
Apply button only appears when using the WaveShaper App and not
on the WaveShaper Webserver.

WaveShaper A Series User Manual

27



3.24 Power Splitting

4000A and 16000A WaveShapers

Power splitting allows the user to power share the input spectrum between up to 4 output ports for the 4000A and 16 ports for the
16000A. This functionality is supported both programmatically and through the WaveShaper GUI.

However, it is important to note that, due to the inherent inefficiency of the power splitting algorithm, there is an additional loss
associated with power splitting. The extra loss is due to unavoidable diffraction effects which introduces additional attenuation to
the WaveShaper depending on the number of active ports.

Number of Active Ports Power Splitting Efficiency (%) Additional Attenuation (dB)

1 100% 0

2 75% 1.25

3 70% 1.55

4-5 60% 2.22

6 55% 2.60

7 50% 3.01

8 45% 3.47

9-11 40% 3.98

12-16 35% 4.56

Note: Table showing the extra loss associated with the power splitting algorithm. This loss is in addition to the inherent loss of the WaveShaper.
Example: Splitting to 2 ports gives a total loss of say 4 dB for the WaveShaper + 3 dB for the power splitting to two ports + 1.25 dB additional
attenuation due to a power splitting efficiency of 75%. Total loss = 8.25 dB.
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3.25 Splitter Controls

Equalize

The “Equalize” button provides a single-click approach to creating an equal
splitting ratio between the selected ports. Select the number of ports and the
equalize button will calculate and immediately upload the required image to
achieve equal parts splitting.

Block

Used to block light going through all selected ports of the WaveShaper

Save Redo/Undo

The save button is disabled – you cannot save profiles created with the GUI.
Additionally due to the computationally-intensive nature of the power splitting
algorithm, Undo/Redo capability is not supported for power splitting.

3.26 Coupling Ratios

Settings

Used to define power splitting ratios to all or only some of the
available ports on the WaveShaper. Click on the 'Apply" button to
upload the required image to the WaveShaper.

The minimum per-port power level that can be set is 1%.

The sum of the total per-port percentages does not have
to equal 100%. This allows attenuation control on a per-
port basis.

The sum of active port percentages must be ≤100%. If
the sum of active port percentages is larger than 100%,
then a warning is generated and the defined splitting
cannot be applied to the WaveShaper until the sum is
≤100%.
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Section 4 Defining Optical Filters

4.1 Optical Filter Files

The WaveShaper Series A supports two different input file formats; *.ucf and *.wsp.

File Type File Suffix Description Supported By

User Configured Filter *.ucf Controls basic WaveShaper Functionality All models except 100A

Preset *.wsp Allows the user to load Preset WaveShaper Configurations All models except 100A

Note: WaveShaper 500A does not support phase control, but can read *.ucf and *.wsp files and apply the amplitude control function therein.

4.2 User Configured Filters (*.ucf)

The ability to load and then easily control user configured filters is key to the operation of the WaveShaper. To this end, the
WaveShaper App supports the same .ucf file import format used in previous versions of the WaveShaper software.

To ensure data integrity, the software will parse and truncate/interpolate the .ucf file to ensure the requested filter shape is
calculated to conform to the limits set by the WaveShaper capabilities. The following rules for preparing and interpreting the .ucf
files therefore apply.

The number of frequency data points must be at least one. The interpolation in the WaveManager software chooses the
attenuation and phase values corresponding to the frequency value that is nearest to the respective frequency in the WaveShaper.
Hence, if there is only one point defined, all frequencies will be set to the same attenuation and phase values defined by that
point. Any WaveShaper frequency outside of the defined frequency range of the input file will be set to the respective edge points
of the input file definition, as that will be the nearest neighbour to these frequencies.

For optimal consistency and portability of .ucf files between different WaveShapers, it is recommended to specify the profiles
down to a resolution of 1 GHz.

File Structure

The format of a ".ucf" file is a tab delimited text file with three columns: Frequency Offset (THz), Attenuation (dB) and Phase (Rad).
The file can be generated using a spreadsheet program, such as Microsoft Excel (saving the document as a tab delimited text file).
The file extension must set to be “.ucf”.

Frequency

The filter frequency is defined in THz as the detuning (positive and negative) from an arbitrary center frequency. The frequencies
do not have to be balanced around the center frequency, but the frequency data set must contain one, and only one, value of
zero, which the WaveShaper interprets as the center frequency. The values in the frequency column must also be monotonically
increasing. Each frequency data point must have a corresponding value of Attenuation and Phase. If no specific attenuation or
phase value is required, values of 0 must be specified at these points.

Attenuation

The calibrated attenuation values available in the WaveShaper hardware are 0 to 30 dB . However, the WaveShaper hardware will
control attenuation down to (maximally) 40 dB and also provides a ‘Block’ state with attenuation of typically >50 dB. To guarantee
the portability of filter shapes between WaveShaper units, the *.ucf attenuation range should be limited to 0-30 dB. The
interpretation of the *.ucf files provides access to the full range of attenuation controls as follows:
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Requested Attenuation *.ucf Interpretation

less than 0 dB Truncated to 0 dB

0 - 30 dB Guaranteed accuracy according to the WaveShaper specification

30.1 - 40 dB WaveShaper attempts to set attenuation to requested value. No guarantee of accuracy

greater than 40 dB Signal set to ‘Block’

Note: Excluding the WaveShaper 100A Tuneable Optical Filter which does not provide attenuation control.

Phase

The phase control range available in the WaveShaper is 0-2π. (Not available for 100A and 500A models.) The User Configured Filter
may specify a phase outside of this range; however this will be re-calculated by the WaveShaper software as input phase mod 2π.

Parameter Units *.ucf Interpretation

Frequency THz Interpolated to fit defined filter bandwidth

Attenuation dB Value dependent

Phase Rad Modulo 2π

Examples of *.ucf files are provided with the software and should be studied to understand the structure of the file.

Note: There is a degree of inter-linking between the amplitude and phase contouring and varying one will have some effect on the
other. In particular, applying large amounts of dispersion to a channel can have a significant impact on the channel amplitude
shape. For full details, see M.A.F. Roelens, J. Bolger, G. Baxter, S. Frisken, S. Poole and B.J. Eggleton, “Dispersion Trimming in a
Reconfigurable Wavelength Selective Switch”, in Journal of Lightwave Technology, vol. 26, p.73, 2008.

Using Microsoft Excel to generate *.ucf files

When using Microsoft Excel to generate a *.ucf file, the following points should be noted.

The file should be saved as Text (Tab delimited, *.txt) file and subsequently renamed to have the suffix “.ucf”.

Before saving as a *.txt file, the format of all columns should be set to ‘Number’ with at least three (3) decimal places. If
the number format is set to less than three decimal places, Excel may misinterpret the data during the translation to a
tab delimited file.

4.3 WaveShaper Presets (*.wsp)

Preset files provide a way to fully define the filter/switch profile of a WaveShaper across all Frequencies and Ports. As such it is a
very powerful tool to easily configure a WaveShaper to a required complex spectrum.

To ensure data integrity, the WaveShaper software parses the .wsp files to ensure the requested filter shape is calculated to
conform to the limits set by the WaveShaper capabilities. The following rules for preparing and interpreting .wsp files therefore
apply.

File Structure

The format of a .wsp file is a tab delimited text file with four columns: Absolute Frequency (THz), Attenuation (dB), Phase (Rad) and
Port. The file can be generated using a spreadsheet program, such as Microsoft Excel (saving the document as a tab delimited text
file). The file extension must be “.wsp” for the file to appear in the File Open dialog box.

Number of Frequency Data Points

Unlike .ucf files, every GHz must be specified for the whole available spectrum in every .wsp file. The first and last points in the file
must be must be within the operating frequency range for the respective WaveShaper model. A partial definition that covers a 
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continuous range within the valid frequency range is also allowed. To avoid interpolation and rounding problems, it is
recommended to check that the frequencies are specified to at least 3 decimal places in the .wsp file.

Frequency

Each frequency data point (specified in absolute terms for *.wsp files) must have a corresponding value of Attenuation, Phase and
Port. If no specific attenuation or phase value is required, values of 0 must be specified at these points.

Attenuation

The calibrated attenuation values available in the WaveShaper hardware are 0 to 30 dB. However, the WaveShaper hardware will
control attenuation down to (maximally) 40 dB and also provides a ‘Block’ state with attenuation of typically >50 dB. To guarantee
the portability of filter shapes between WaveShaper units, the attenuation range should be limited to 0-30 dB. However, the
interpretation of the *.wsp files provides access to the full range of attenuation controls are the same as for *.ucf files.

Requested Attenuation *.wsp Interpretation

less than 0 dB Truncated to 0 dB

0 - 30 dB Guaranteed accuracy according to the WaveShaper specification

30.1 - 40 dB WaveShaper attempts to set attenuation to requested value. No guarantee of accuracy

greater than 40 dB Signal set to ‘Block’

Note: Excluding the WaveShaper 100A Tuneable Optical Filter which does not provide attenuation control.

Phase

The phase control range available in the WaveShaper is 0-2π. (Not available in the 100A and 500A models, phase must be is set as
0.) The *.wsp file may specify a phase outside of this range; however, this will be re-calculated by the WaveShaper software on
interpolation as (phase modulo 2π).

Parameter Units *.wsp Interpretation

Frequency THz Interpolated to fit defined filter bandwidth

Attenuation dB Value dependent

Phase Rad Modulo 2π

Port

The port range available depends on the WaveShaper model.

Model Ports Available

500A,
1000A The port needs to be either 1 or 0, where 0 corresponds to the block state, and 1 to the only available output port.

4000A The output port can be set to 0, 1, 2, 3, or 4, where 0 corresponds to the block state.

16000A The alpha-numeric port combination (e.g. A-1) is referenced by a sequential port number. Consult the tables below
to identify the port number for each configuration. Block is again signified by port 0.
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4x16 configuration - 64 ports total

INPUT OUTPUT PORT#

A 1 1

... ... ...

A 16 16

B 1 17

... ... ...

B 16 32

C 1 33

... ... ...

C 16 48

D 1 49

... ... ...

D 16 64

The port numbers for 4x16 configuration. This is the default
configuration for the 16000A.Note that the WaveShaper App
version 1.01 only supports the 1x19 configuration. For the other
configurations, please upgrade to WaveShaper App 1.2+ or use
WaveManager 2.7.4.

1x19 configuration - 19 ports total

INPUT OUTPUT PORT#

A B 1

A C 2

A D 3

A 1 4

A 2 5

... ... ...

A 15 18

A 16 19

The port numbers for 1x19 configuration
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8x12 configuration - 96 ports total

INPUT OUTPUT PORT#

A 5 1

... ... ...

A 16 12

B 5 13

... ... ...

B 16 24

C 5 25

... ... ...

C 16 36

... ... ...

... ... ...

4 5 85

... ... ...

4 16 96

The port numbers for 8x12 configurationNote that the WaveShaper
App version 1.01 only supports the 1x19 configuration. For the
other configurations, please upgrade to WaveShaper App 1.2 or
use WaveManager 2.7.4.

10x10 configuration - 100 ports total

INPUT OUTPUT PORT#

A 7 1

... ... ...

A 16 10

B 7 11

... ... ...

B 16 20

C 7 21

... ... ...

C 16 30

... ... ...

... ... ...

6 7 91

6 16 100

The port numbers for 10x10 configurationNote that the
WaveShaper App version 1.01 only supports the 1x19
configuration. For the other configurations, please upgrade to
WaveShaper App 1.2 or use WaveManager 2.7.4.
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Section 5 Programming

5.1 RESTful Interface

Web Services

The WaveShaper provides a RESTful style Web service API that enables configuring the device and access to measurement data
using HTTP commands from a Web browser or from a software programming language.

Communication with the Series A WaveShapers can be done directly through the browser. Most major languages support sending
and receiving http requests via 3rd party tools, although some provide native support.

LANGUAGE HTTP SUPPORT

LabVIEW natively via HTTP Client VIs

Python requests library

MATLAB

webread / webwrite (R2014b onwards)

urlread2, 3rd party (http://au.mathworks.com/matlabcentral/fileexchange/35693-urlread2)

urlread (not recommended)

Octave
wget/curl system calls

urlread (not recommended)

C/C++ libcurl library

Java Apache HttpClient

Javascript/Node.js Natively via http.get

C#/VB.NET System.Net

JSON

The response data is in JSON format. This stands for JavaScript Object Notation which is a lightweight and human readable data
format.

JSON is supported by most languages either natively or via 3rd party libraries. An extensive list can be found at
http://www.json.org/

Some languages have many to choose from, and personal preference is usually the deciding factor.
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LANGUAGE JSON SUPPORT

LabVIEW natively via JSON VIs

Python Natively via json library

MATLAB/Octave JSONlab, 3rd party, (https://au.mathworks.com/matlabcentral/fileexchange/33381-jsonlab--a-toolbox-
to-encode-decode-json-files)

C++
Jsoncpp, 3rd party, (https://github.com/open-source-parsers/jsoncpp/wiki)

Plus several others…

Java
Gson, 3rd party, (https://github.com/google/gson)

Plus several others…

Javascript/Node.js Natively via JSON.parse

C#/VB.NET Several available…

5.2 HTTP API Basics

The WaveShaper uses HTTP GET/POST methods to configure the instrument and upload a filter function. The WaveShaper Web
server can be accessed via all available connection methods, with different approaches to defining its IP address.

The most common use case is uploading a filter profile to a WaveShaper. A Web browser can send an HTTP POST request to the
WaveShaper Web server, to send the filter profile. For more complex automation, modern programming languages support HTTP
requests through common libraries.

Upload Filter

Description: Upload filter profile to the WaveShaper

HTTP method: POST

URL: http://<_ip_>/waveshaper/loadprofile

POST Data: JSON formatted request includes the following fields.

JSON FIELD DESCRIPTION

type Filter type with one of the following options: wsp, blockall, transmit, bandpass, bandstop, gaussian

wsp wsp filter definition stringonly used when tye is wsp

port(number) Port valueonly used when the type is bandpass, bandstop or gaussian

center(number) Center frequency in THzonly used when the type is bandpass, bandstop or gaussian

bandwidth(number) Filter bandwidth in THzonly used when the type is bandpass, bandstop or gaussian

attn(number) Attenuation in dBonly used when the type is bandpass, bandstop or gaussian

Response: JSON formatted response includes the following fields.

JSON FIELD DESCRIPTION

rc(number) Result code

msg Result in text format

sno WaveShaper serial number
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Retrieve WaveShaper device information

Description: Retrieve information about the WaveShaper

HTTP method: GET

URL: http://<_ip_>/waveshaper/devinfo

Response: JSON formatted response includes the following fields.

JSON FIELD DESCRIPTION

model WaveShaper model

sno WaveShaper serial number

ver) Firmware version

startfreq(number) Start frequency

stopfreq(number) Stop frequency

ip Current IP address

portcount(number) Number of output port(s)

msg Result in text format

Retrieve currently loaded WaveShaper profile

Description: Retrieve currently loaded WaveShaper filter profile

HTTP method: GET

URL: http://<_ip_>/waveshaper/getprofile

Response: Currently loaded WaveShaper filter profile encoded in WSP formatted string.

5.3 Programming Examples

Overview

The WaveShaper comes with a collection of programming examples for LabVIEW, MATLAB and Python. Each example
demonstrates a set of basic functions including: retrieving device information, uploading arbitrary filter shapes, and saving and
loading WSP filter files. These examples also demonstrate how HTTP commands and JSON strings work together to control your
instrument

Examples

Each example demonstrates a different commonly used WaveShaper function. A complete copy of the code examples may be
downloaded from within the help section of the WaveShaper Software. Here is an overview:

Example_UploadPredefinedProfile

Demonstrates how to program the WaveShaper with a predefined filter shape. This example configures the WaveShaper with a
bandpass filter with a center frequency of 194 THz; bandwidth 1 THz; 0 dB attenuation; and assigned to Port 1. Experiment with
changing the filter shape e.g. to a gaussian, or bandstop filter. The WaveShaper may also be configured to a full transmit or a
blockall state with this mode.

Example_UploadProfile

Demonstrates how to upload an arbitrary filter shape to your WaveShaper. The code example achieves this by generating a WSP
string programmatically. It shows how device information can be retrieved from the device via the /waveshaper/devinfo API
command. Experiment with changing the attenuation or phase functions to see how powerful this feature is.
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Example_UploadProfileFromFile

Demonstrates how a pre-existing WSP file may be easily uploaded to the WaveShaper.

WSMethods Function Set

The examples make use of a set of lower-level functions that may be used to meet a wider variety use-cases. Here is an overview:

createWspString

This function is used to combine a set of frequency, attenuation, phase and port arrays into a single WSP string. This string may be
directly uploaded to the WaveShaper, or saved to file for later use.

splitWspString

This function is used to parse a WSP string into a set of frequency, attenuation, phase and port arrays. These arrays may then be
processed in any way that fits your application.

uploadProfile

This function simplifies the task of uploading arbitrary filter shapes by abstracting away the handling of JSON strings and HTTP
commands.

uploadPredefinedProfile

This function simplifies the task of uploading predefined profile by abstracting away the handling of JSON strings and HTTP
commands.

5.4 Python Examples

The Python example code below is written for use with Python 3. In addition, the following packages must be installed:

numpy

requests

json

A complete copy of the code examples may be downloaded from within the help section of the WaveShaper Software.

Example_UploadPredefinedProfile.py

     
import requests 
import json 
from WSMethods import * 
 
# Define device IP 
ip = '169.254.6.8'
# Define profile according to API 
profileType = 'bandpass'# blockall, transmit, bandpass, bandstop, gaussian 
centerFreq = 194.000    # THz 
bandwidth = 1           # THz 
attenuation = 0         # dB 
port = 1 
 
# Upload predefined profile using above definition 
r = uploadPredefinedProfile(ip, profileType, centerFreq, bandwidth, attenuation, port)
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Example_UploadProfile.py

Example_UploadProfileFromFile.py

5.5 MATLAB Examples

The MATLAB example code must be used with MATLAB version R2014b and above in order to support native web read
functionality. It is recommended to use MATLAB version R2016b and above in order to support native JSON functionality. The
JSONLab 3rd party toolbox may be used for MATLAB versions prior to R2016b.

A complete copy of the code examples may be downloaded from within the help section of the WaveShaper Software.

     
import requests 
import json 
import numpy as np 
from WSMethods import * 
 
# Define device IP 
ip = '169.254.6.8' 
 
# Get device info  
result = requests.get('http://' + ip + '/waveshaper/devinfo').json() 
 
# Set frequency variables from device info 
s = result['startfreq'] 
e = result['stopfreq'] 
 
# Create data for wsp 
wsFreq = np.linspace(s, e, int((e-s)/0.001 + 1)) 
wsAttn = 50*np.power(np.sin(2*np.pi/0.5*(wsFreq-193)),2) 
wsPhase = np.zeros(wsFreq.shape) 
wsPort = np.ones(wsFreq.shape) 
 
# Upload profile using created data 
r = uploadProfile(ip, wsFreq, wsAttn, wsPhase, wsPort)

     
import requests 
import json 
import os 
from WSMethods import * 
 
# Define device IP 
ip = '169.254.6.8' 
 
# Read the "wspTestFile.wsp" file from the same directory as this .py file 
string = open(os.path.join(os.path.dirname(__file__),'wspTestFile.wsp')).read()
# Run splitWspString() function using the WSP string from the file 
wsFreq, wsAttn, wsPhase, wsPort = splitWspString(string)
# Upload profile using split data 
r = uploadProfile(ip, wsFreq, wsAttn, wsPhase, wsPort)
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Example_UploadPredefinedProfile.m

Example_UploadProfile.m

     
addpath('WSMethods') 
 
% Define device IP 
ip = '169.254.6.8'; 
 
% Define profile according to API 
profileType = 'bandpass';   % blockall, transmit, bandpass, bandstop, gaussian 
centerFreq = 194.000;       % THz 
bandwidth = 1;              % THz 
attenuation = 0;            % dB 
port = 1; 
 
% Upload predefined profile using above definition 
r = uploadPredefinedProfile(ip, profileType, centerFreq, bandwidth, attenuation, port);

     
addpath('WSMethods') 
 
% Define device IP 
ip = '169.254.6.8'; 
 
% GET device info and decode JSON 
result = webread(['http://', ip, '/waveshaper/devinfo']); 
result = jsondecoder(result); 
 
% Set frequency variables from device info 
s = result.startfreq; 
e = result.stopfreq; 
 
% Create data for wsp 
wsFreq = linspace(s, e, (e-s)/0.001 + 1);  
wsAttn = 50*sin(2*pi/0.5*(wsFreq-193)).^2; 
wsPhase = zeros(size(wsFreq)); 
wsPort = ones(size(wsFreq)); 
 
% Upload profile using created data 
r = uploadProfile(ip, wsFreq, wsAttn, wsPhase, wsPort);
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Example_UploadProfileFromFile.m

5.6 LabVIEW Examples

The LabVIEW example code has been saved for LabVIEW 2015, and is not compatible with previous versions.

A complete copy of the code examples may be downloaded from within the help section of the WaveShaper Software.

Example_UploadPredefinedProfile.vi

Example_UploadProfile.vi

Example_UploadProfileFromFile.vi

     
addpath('WSMethods') 
 
% Define device IP 
ip = '169.254.6.8'; 
 
% Open the "wspTestFile.wsp" file from the same directory as this file 
string = fileread('wspTestFile.wsp'); 
 
% Run splitWspString() function using the WSP string from the file
[wsFreq, wsAttn, wsPhase, wsPort] = splitWspString(string); 
 
% Upload profile using split data 
r = uploadProfile(ip, wsFreq, wsAttn, wsPhase, wsPort);
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5.7 Power Splitting Programming

The power splitting function can be invoked programmatically using the following “Post” command:

URL: http:// <_ip_>/waveshaper/loadsplitter

Post Body:

where P n is the power expressed as a normalized proportion of the total power.

Examples

4-way splitter with 20% of the power in Port 1, 20% in Port 2, 40% in Port 3 and 20% in Port 4:

URL: http:// <_ip_>/waveshaper/loadsplitter

Post Body:

2-port coupler on ports 2 and 3 with equal splitting between the two coupler outputs:

URL: http:// <_ip_>/waveshaper/loadsplitter

Post Body:

4-way equal-power splitter with an additional 3dB of attenuation programmed in:

URL: http:// <_ip_>/waveshaper/loadsplitter

Post Body:

{ 
    "port1" : P1, 
    "port2" : P2, 
    "port3" : P3, 
    "port4" : P4
}

{ 
    "port1" : 0.2, 
    "port2" : 0.2, 
    "port3" : 0.4, 
    "port4" : 0.2
}

{ 
    "port1" : 0, 
    "port2" : 0.5, 
    "port3" : 0.5, 
    "port4" : 0
}

{ 
    "port1" : 0.125, 
    "port2" : 0.125, 
    "port3" : 0.125, 
    "port4" : 0.125
}
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Return messages

In all cases, a successful Post command will return the following:

It is the user’s responsibility to ensure that the sum of the normalized port power must be ≤ 1. The WaveShaper performance is not
defined for values >1. If the sum of the normalized port power is >1, then the following error message will be returned:

Care should be taken to ensure that the formatting of the command is correct. An incorrectly formatted command (e.g. missing
the leading “0” in a value for Pn) will generate the following error message:

{ 
    "msg" : "OK", 
    "rc" : 0
}

{ 
    "msg" : "OK", 
    "rc" : 0
}

{ 
    "rc" : -1, 
    "msg" : "error:invalid json format"
}
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Section 6 Specifications

6.1 Optical Specifications

This table gives a summary of the optical specifications for the entire WaveShaper Series 'A' range

MODEL SPECIFICATION 100A 500A 1000A/4000A 16000A 1000A/SP 1 1000A/L,4000A/L 1000A/X,4000A/X

Optical
Ports Port Configurations 1x1 1x1 (1000A)1x1

(4000A)

1x19,
4x168x12,

10x10
1x1 1x1 (1000A)1x1 (4000A)

Filter
Control

Operating
Frequency Range 191.1 THz to196.46 THz(1526.0 nm to1568.7 nm)

191.250 THz to196.275
THz(1527.4 nm
to1567.5 nm)

186.20 THz to191.05
THz(1569.2 nm
to1610.0 nm)

187.275 THz to196.275
THz(1527.4 nm
to1600.8 nm)

Filter Bandwidth
10 GHz to1

THz(0.08nm to8
nm)

10 GHz to5.36 THz(0.08nm
to42.7nm)

10 GHz to5 THz(0.08
nm to40 nm)

10 GHz to4.85
THz(0.08 nm to40.8

nm)

20 GHz to9 THz(0.016
nm to73.4 nm)

Filter Shaper BandpassGaussian Arbitary

Filter Setting
Resolution ±1 GHz (±8 pm)

Filter Setting
Accuracy ± 2.5GHz (± 8pm) ±5 GHz

Bandwidth Setting
Resolution ±1 GHz (±8 pm)

Bandwidth Setting
Accuracy ±5 GHz (±40 pm) ±10 GHz

Bandwidth Setting
Repeatability ±2.5 GHz (±20 pm) ±5 GHz

Group Delay
Control Range n/a -25 ps to +25 ps -15 ps to +15 ps

Attenuation
Control Range n/a 0 to 35dB

Attenuation
Setting Resolution n/a 0.01 dB 0.1 dB 0.01 dB

Attenuation
Setting Accuracy n/a ±1.0 dB from 0 to 10 dB, ±10 % from 10 to 30 dB

Settling Time <500 ms

Loss and
Dispersion

Insertion Loss < 5 dB < 6.5 dB

Insertion Loss Non-
Uniformity 0.7 dB 0.7 dB 2 1 dB

Polarization
Dependent Loss

(PDL)
0.4 dB n/a 0.4 dB 0.8 dB

Differential Group
Delay (DGD) < 0.5 ps n/a < 0.5 ps

Return Loss > 25 dB

Optical
Power

Max. Total Input
Optical Power > 25 dB

Max. Optical Power
per 50GHz Channel + 27 dBm

Mechanical Connector
Interface FC/APC FC/UPCFC/APC LC/APC FC/APC

Note 1: Measured on signal in slow axis.Note 2: Specification is valid over the frequency range of 187.0 to 191.0 THz. From 186.35 to 187.0 THz the insertion loss non-uniformity is <
1.0 dB max.

Warm-Up Time

The device will meet all specifications following a warm-up period of 10 minutes from a temperature within the normal operating
temperature range.
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6.2 Electrical Specifications

Module Power Supply

DESCRIPTION/PARAMETER UNIT MIN TYPICAL MAX NOTES

Power Consumption W 19 50 Typical at 25°C after warm-up period, Maximum power
consumption occurs during initial stages of warm-up period

Power Supply V 4.75 5.00 5.25 Measured at Phoenix Connector

External Interfaces to Module

DESCRIPTION INTERFACE NOTES

Ethernet Connector RJ-45

Power Connector Phoenix Plug Phoenix connector supplied with module

USB Connector Mini USB 2.0

Reset Pins Jumper

Note: Due to the supply wire resistance, the voltage can drop significantly between the power source and the terminal. The supply wire gauge
should be chosen to be able to deliver up to 10 A.

Rear view of the Series A module showing the Ethernet, USB, power supply and reset pins

Benchtop Power Supply

DESCRIPTION/PARAMETER UNIT MIN TYPICAL MAX NOTES

Power Consumption W 20 50 Typical at 25°C after warm-up period, Maximum power
consumption occurs during initial stages of warm-up period

Power Supply Voltage (AC) V 100 240

Power Supply Frequency Hz 50 60

External Interfaces to Benchtop

DESCRIPTION INTERFACE

Power Connector IEC

USB Connector USB 2.0, Type B

Ethernet Connector RJ-45
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Rear view of the Series A benchtop showing the power supply, fan, USB, Ethernet, reset button and serial number.

6.3 Environmental Conditions

Storage Conditions

The WaveShaper should be stored in appropriate dry, temperature controlled conditions to prevent damage to the equipment.
Exceeding the ranges defined in the table may result in permanent damage to the equipment.

Absolute Maximum Ratings

CONDITION / PARAMETER UNIT MIN MAX NOTES

Storage Temperature °C -20 +70

Storage Humidity % 10 90 Non-condensing

Case operating temperature °C 15 55 Module Only

ESD kV 16 Class N per HBM, meets IEC 61000-4-2 level 4

Exceeding the ranges defined here may result in permanent damage to the unit.

Normal Operating Conditions

CONDITION / PARAMETER UNIT MIN MAX NOTES

Operating Temperature
(module)

°C 15 55 Temperature of case with airflow across top of unit. Min flow rate =
1m/sec.

Operating Temperature
(benchtop)

°C 15 35 Air temperature measured at input to vents on base of unit

Humidity % 10 90 Non-condensing

The device will operate within specification provided these operating conditions are met.
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